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Documentation Conventions
Courier typeface is used to illustrate command syntax, command names, and signal names.

Courier bold typeface illustrates user input, the names of buttons in dialog boxes, and the
names of bar menu buttons.

Italic type is used to indicated keyword-fields in commands and file names.

<key> (angle brackets surrounding this typeface) identifies a function key or a special keyboard
key.
[] right braces identify optional items in commands and description statements.
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Xpower Users Guide

Overview

The Xpower program estimates the dynamic power consumption a CMOS circuit for a specific
test stimulus sequence. It uses signal state history and loading information supplied by the SIMIC
logic simulator. This information is scanned, and the energy consumed per test is calculated by
summing the number of nodes that undergo state transitions, where each node is weighted by its
capacitive loading.

Xpower displays dynamic power consumption utilizing X-window! graphics, and optionally gen-
erates a corresponding PostScript2 description for subsequent printout. It displays this information
in two ways, one showing the power distribution for the entire stimulus sequence, and the other
showing the power dissipation for a selected set of test vectors. The latter display can be panned
or zoomed to change the selected set of tests to be viewed. In each window, the average for the
data in the display is indicated. A window can be summoned that reports the average power con-
sumption and the test where maximum power consumption occurs.

In order to use Xpower, SIMIC History and Query Loading files must have been created in a prior
SIMIC session.

Power Consumption

Xpower computes dynamic power consumption in normalized units of mW/MHz. This section
describes the computed value, the scaling factors you should use to obtain actual dynamic power
consumption, and other types of power consumption not addressed by Xpower.

Xpower Normalized Values

Dynamic power consumption is calculated from the capacitive energy stored and retrieved at each
node whenever a signal transition occurs. This energy is calculated using the formula:

E = %xCx(AV)Z (1)
where C is the nodal capacitance, and AV is the high to low (or low to high) change in voltage,

which is usually the supply voltage, VVdd. This formula is valid as long as the charging time is suf-
ficiently greater than the effective RC time-constant for the node, which is generally the case.

Xpower assumes that capacitive loading is expressed in farads and that \Vdd is 5 volts. If this is
not the case, the actual values can be entered (see Modifying Calculation Parameters on page 14).

1. The X Window System is a trademark of Massachusetts Institute of Technology.
2. PostScript is a registered trademark of Adobe Systems Inc.
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The normalized total power consumption computed by Xpower is:

>
Py = Bl nodesTh et x 10° (2)
N
where:
Ph is the normalized power consumption.
E; is the energy stored or retrieved at the i-th active node in Test t (from Equation 1).
N is the total number of test stimuli.

The 10° factor scales power from watts to milliwatts (10%) and normalizes time to usec (109).

Obtaining Actual Power Consumption

To obtain the actual dynamic power consumption from the normalized value, use the formula:

P= P, xF, x ;)elsctsé 3)
where:
P is the actual power consumption in milliwatts
Py is the normalized power consumption reported by Xpower (from Equation 2)
Fn is the normalized master clock frequency in Mhz (e.g., if the master clock fre-

quency is 7Mhz, then F, = 7)
tests/cycle is the number of test stimuli corresponding to a single master clock cycle.

Equation 2 implicitly assumes a correspondence between test duration and master clock period. If
the master clock is defined as a timing generator having RZ (return-to-zero) format, then each test
period corresponds to a single clock cycle, and the tests/cycle multiplier should be 1. If the master
clock is defined as a timing generator having NRZ (non-return-to-zero), then two test periods
could correspond to a single master clock cycle, and tests/cycle should be 2.

If simulate-until-stable or waveform mode stimuli were used in the simulation, then tests/cycle
would be at least 2, since this is the minimum number of tests required for each clock pulse’s ris-
ing and falling edges. In general, as long as the master clock is periodic, this multiplier can be
obtained from the formula:

tests N 4)
cycle — NcL
where:
N is the total number of test stimuli in the simulation
Sl is the total number of clock cycles in the simulation.

If the clock signals are aperiodic, or if the circuit is asynchronous, Equation 5 should be used in
place of Equation 3 (this equation is valid for all situations):
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R ©)
where:
N is the total number of test stimuli in the simulation
Tsim is the total simulation time interval in psec.

Other Sources Of Power Dissipation

Xpower filters out the energy dissipation contributions from external sources, i.e. primary inputs
and bidirectional pads. In addition, through a command file, the user can indicate other signal
transitions that need to be discounted. There are a few other contributions to power dissipation
that Xpower does not take into account:

(1) Power consumption due to leakage current. In low frequency circuits, static leakage cur-
rents may cause a continuous power dissipation that is comparable in magnitude to the
dynamic component. This leakage current is usually calculated by summing values
found in the data sheets for each instantiated cell.

(2) Transient I°R dissipation due to transistor switching times. When CMOS circuits
undergo a state transition, there may be a time where pullup paths to VVdd and pulldown
paths to ground connected to the same node are conducting simultaneously, allowing a
low resistive path for current to flow. Except for heavily-loaded gate inputs with high
slew rates, this current is normally of short duration compared to the capacitive dynamic
currents.

(3) Spikes and other transient phenomena. The importance of glitches and narrow pulses
grows with increasing operating frequency. These effects are very difficult to properly
account for without precise analog simulation of the devices.

(4) 1°R dissipation due to conduction paths through pullup and pulldown resistors.

Generating SIMIC History Information

SIMIC’s history command controls the creation and content of the history files. Two files are
created, with file extensions hig and his. This section contains a brief synopsis of the
history command.

The history command must be issued to SIMIC prior to the simulate command. The format
of the history command is:

history list [file] [prange]

where:
list is either:
(@ LIST: - specifying all signals are to be included in the history information, or
(b) LIsT=listofsignals — listofsignals is a list of signals separated by commas or
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whitespace, specifying which signals to include in the history information. Note that
SIMIC wildcarding and Meta-signals (&INPUTS, &OUTPUTS, &BUSINS, &BUS-
SES) for primary inputs, outputs, bus-inputs and bus-outputs respectively, are allowed.

file is an optional keyword field consisting of either:
(@ FILE: - indicating that the default file name is the name to use for the history files, or
(b) FILE=filename — filename is the name to use for the history files.

If file is omitted, FILE : is assumed.

prange is an optional keyword field consisting of the keyword PRANGE= followed by a list of
stimulus ranges. This is used to suppress history information during portions of the simulation
that are not of interest, thus reducing the size of the history files. If prange is omitted, then no his-
tory information will be suppressed during the simulation.

For example, the SIMIC command:
history list: file=mychip

causes all signal activity to be written to the files mychip.higand mychip.his for the entire
simulation.

Power consumption calculations will only be applied to the signals found in the history and load-
ing files. In this way, sections of the chip can be analyzed independently.

For further information on the history command and its options, see the SIMIC User’s Guide.

Generating The Query Loading File

The Query Loading file is an ascii file containing loading information in the following format:

node name: Loading= value

where
node_name is the name of the node that the corresponding loading value is to be applied to.
value Is any positive (or zero) real number.

For example:

ABEUR: Loading= 1.072

assigns the loading of 1.072 capacitive units to the node named ABEUR. The simplest method of
generating this file is to let SIMIC do it for you. After loading in the circuit and backannotated
loading (if required) with the SIMIC GET command, issue the Query loading command with the
file option using the following format:

?loading list file

where:
list is either:
(@ LIST: - specifying all signals are to be included in the loading information, or
(b) LIsT=listofsignals — listofsignals is a list of signals separated by commas or

whitespace, specifying which signals to include in the loading information. Note that
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SIMIC wildcarding and Meta-signals (&INPUTS, &OUTPUTS, &BUSINS, &BUS-
SES) for primary inputs, outputs, bus-inputs and bus-outputs respectively, are allowed.

file is a keyword field consisting of either:
(@ FILE: - specifies that the loading file should have the default file name and the
default extension gry, or

(b) FILE=filename — filename is the name to use for the query file (if this name does not
specify a file extension, the default extension gry is implied).

The list keyword option should be identical to the one used in the companion history com-
mand.

For further information on the Query loading (?loading) command and its options, see the
SIMIC User’s Guide.

Details Of The Xpower Environment

Correcting Typographical Errors

Several options are specified to Xpower by typing them in dialog box windows. If you make a
mistake while typing, the error can be corrected by using the left and right arrow keys to position
the character cursor to the error (if necessary), the <Delete> key to delete the character under the
cursor, and the <Backspace> key to delete the character to the left of the cursor. Also, typing
with the cursor positioned inside the text overwrites the text to the right of the cursor. You may
insert text instead by pressing the <Ins> (Insert) key. The dialog box window will remain in insert
mode until the <Ins> is pressed again, or until the dialog box window is closed.

Case Sensitivity

All keyboard input in dialog box windows is case sensitive.

Mouse Buttons

Certain Xpower operations require use of the mouse. One of the buttons, called the SELECT but-
ton, performs special functions, such as setting input focus for user input. Typically, the SELECT
button would be the left mouse button, but this is not always the case; thus, experimentation may
be necessary for some systems.

Dialog Box Text Entry Windows

Some dialog boxes, such as the Filename dialog box illustrated in Figure 2, have multiple win-
dows for entering text. One of the text entry windows will have input focus, that is, will be high-
lighted and ready to accept keyboard input. In order to set the input focus to a different text entry
window, move the mouse cursor into the text entry window and press the mouse SELECT button.
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Option Buttons

Option buttons are buttons that support multiple actions. For example, the Signal Select Box con-
tains two option buttons, one of which is illustrated in Figure 1(see the Section Selecting Signals
For Analysis for a description of this button’s options). As shown in Figure 1(a), an option but-
ton’s label displays the action that will be performed if the button is “pressed”; in this case, Select
Filtered.

Included: Inc luded:

SelectFilered ~ _I SelectFiltered |||
Select All

AD Deselect Filtered

ABEUR Deselect All

ABEN ivert

AENB
Search Down

ABSB =

AD121 Search Lp

AD122 AD122

(a) An Option Button (b) An Option Button Menu

Figure 1 An Option Button and Its Menu

When the option button is “pressed”, its menu of possible actions pops up over the button, with
the action corresponding to the button’s label selected, as shown in Figure 1(b). Releasing the
mouse’s SELECT button will cause the action to be performed (Select Filtered in this example).
If, instead, the mouse cursor is dragged vertically through the pop up menu to another action
before the SELECT button is released, this other action (e.g., Invert) will be performed, and sub-
sequently will become the option button’s label. If the mouse cursor is dragged outside the pop up
menu before the SELECT button is released, then no action is performed. In all cases, the menu
disappears when the SELECT button is released.

Alternatively, “pressing” the rectangular knob inside the option button causes the pop up menu to
appear and remain on the screen. Selection can then be made either with the mouse, as above, or
with the keyboard by (a) typing the single character underlined in each menu item (f, s, I, d. or i in
this example) or (b) using the keypad up and down keys to move along the menu and pressing the
<Return> key to perform the selected action. The pop up menu can be dismissed without making
a selection by clicking the mouse SELECT button anywhere outside the menu.
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Starting Xpower

Xpower is invoked with the system command:
Xpower [-c command] [history [loading] ]
where:
command is the full name of the command file.
history  is the common name of the history files, possibly containing their path name if
these files are not in the working directory.
loading s the full name of the loading file.

If the loading file has the same name as the history files and its extension is gry, then the loading
argument is optional. For example, if the names of these files are mychip.hig, mychip.his,
and mychip.qgry, then Xpower could be invoked with the command:

Xpower mychip

If the history file name is not specified in the command line, Xpower will display the Filename
Dialog Box shown in Figure 2, requesting the common name of the history files. Enter this name
in the History File text entry window, as shown in the figure. If the loading file has the same
name and its extension is gry, the loading file need not be specified; otherwise, specify its full
name in the Loading File text entry window. Optionally, a command file can be specified in the
Command File text entry window. Press the OK button to accept the entered filename(s), or the
Cancel button to exit Xpower. Help is available via the Help button.

History File:
Find |
Loading File:
Find
Command File:
| Find
ok | camcel| Hep|

Figure 2 Filename Dialog Box
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If Xpower cannot find the specified history files, it displays the Correct History File Name dia-
log box shown in Figure 3(a). If it cannot find the loading file (either explicitly specified or
implied from the history files’ filename), it displays the Correct Loading File Name dialog box
shown in Figure 3(b). If it cannot find the command file, it displays the Correct Command File
Name dialog box shown in Figure 3(c). Placing the cursor over the OK button and clicking the
SELECT mouse button causes the Filename Dialog Box to appear for re-specifying the file
names. Clicking the SELECT mouse button with the cursor over the Cancel button causes
Xpower to exit.

Cannot Open History File.
Flease Correct.

‘ ok | cancel

Figure 3(a) Correct History File Name Dialog Box

Cannot Open Loading File.
Please Correct.

‘ oK | cancel

Figure 3(b) Correct Loading File Name Dialog Box

Cannot Open Command File.
Please Correct.

‘ ok |  cancel

Figure 3(c) Correct Command File Name Dialog Box
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To the right of each text entry field is a Find button. Pressing the Find button brings up a File
Selection Dialog Box for the corresponding file type. This Dialog box allows you to browse for
existing files, and optionally select the entry for the corresponding file in the Filename Dialog
Box. The History File Selection Dialog Box is shown in Figure 4; the Loading and Command
File Selection Dialog Boxes are similar. This Dialog box contains a number of panels.

Filter:

fhomesgenashor/test/mychips= . hig

Directories: Files:
. kY mychip.hig kY
. shiftl00,.hig
mychipl test.hig
mychipZ
% %
I |- I |-
Selection:

Figure 4 File Selection Dialog Box

The Filter panel displays the path to the directory and the search filter for the files in this direc-
tory. In this search filter, * and ? are wildcards; an asterisk (*) specifies that any sequence of
characters will match, and a question mark (?) specifies that any single character at the position of
the question mark will match. For example, the path displayed in Figure 4 is /home/gena-
shor/test/mychip/ and the file search filter is * . hig, which specifies that all files in this
directory whose names end with . hig should be included in the Files list. In general, only the
directory portion of the Filter string should be modified (however, the file filter could be changed
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to *.his, which would also create an acceptable list of history files for selection). In order to
enable the modified filter, you must press the Filter button on the bottom of the Dialog box.

Below the Filter panel are two scrolling lists, labeled Directories and Files. The Directories list
shows the directories found in the current Filter path. Note that *.”, specifies the current direc-
tory, and “. .” specifies the parent directory. Selecting one of the directories in this list causes that
directory to become the current one. Selection can be made with the keyboard by positioning the
cursor over the selection and pressing the <Return> key, or with the mouse by double clicking on
the proper directory. The Files list displays the files in the current directory that match the filter.
Note that in Figure 4, only the . hig files are displayed, since they are the only files that match
the “* . hig” filter. Selecting an item from this list will cause it to be displayed in the Selection
panel. The Selection panel contains the currently selected file. You may enter a filename directly
here, rather than using the above method; entries of the form filename, filename.hig, and
filename.his are all acceptable. Once this panel contains the file you want, pressing the OK
button will select the history files, but they will not be read until the OK button of the Filename
Dialog Box is pressed. Pressing Quit at any time will dismiss the File Selection Dialog box.
Pressing Help provides some on-line help information about opening the history files.

Exiting Xpower

To exit Xpower, select File in the bar menu (see Selecting Items In The Bar Menu Area below).
This causes the File item’s pulldown menu to appear, as shown in Figure 5. Then, select Exit to
quit the program.

File | Display
Open |
Save

= o
Restore
Print

Exit |13
I

Figure 5 File Item’s Pulldown Menu

The Xpower Display

As shown in Figure 6, the Xpower display contains three main areas:
(1) Atthe top is a bar menu with selections for: File, Setup, View, Signals, Info, and Help.
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(2) Directly below this menu is a dissipation graph area. This area is used by Xpower to
display the dynamic power consumption for each test. A dotted reference line shows the
average power consumption level; however this average is taken over the displayed
area, not over the complete test stimulus set.

(3) Below the dissipation graph area is a scroll bar used to scroll the graph horizontally.

The initial size of the Xpower display is the default size; it cannot be made any smaller. However,
its size can be increased. To resize the display, move the mouse cursor to one of the resize han-
dles, located at the outside corners of the display’s border (the cursor changes shape when it is
over the handle). Then, press the SELECT mouse button and drag the resize handle until the dis-
play attains the desired size. The initial size and placement and a variety of other display prefer-
ences can be set from the X-resource file (see X-Resources Used By Xpower on page 29).

At the start of the program, the full simulation history is analyzed and displayed in the graph area,
as shown in Figure 6.

Fie Display View Signals Info Bar Menu Area Help
Oynamic Fower Dissipation
Vector Power (mll/MHz) wvs., ‘Vector MNHumber
20) Dissipation Graph
T Area
15 —
10 —
o
0
0 10000 20000 [Z0000
H Dissipation Graph Scroll Bar | -

Figure 6 The Xpower Display
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Selecting Items In The Bar Menu Area

The bar menu has five items for selection: File, Display, View, Info, and Help. Each item can be
selected by pressing the SELECT mouse button while the mouse cursor is over the item. Alterna-
tively, the <F10> key will select the bar menu. Items in the bar menu can then be selected either
by pressing the key corresponding to the underlined letter of the item, or by using the left/right
arrow keys. You may use the down arrow to display pulldown menus and then the up/down keys
to walk the items in the pulldown menu. The menu items are selected by pressing the <Return>
key. Pressing <F10> again will deselect the bar menu, as will clicking the SELECT mouse button
anywhere outside the pulldown menu.

Panning And Zooming The Dissipation Display

Panning Using The Scrollbar

The scrollbar underneath the dissipation area can be used to pan through simulation tests. Refer-
ring to Figure 7:
(@ Clicking any mouse button with the cursor over the left arrow causes the dissipation dis-
play to move backward one test.

(b) Clicking any mouse button with the cursor over the right arrow causes the dissipation
display to move forward one test.

(c) Clicking any mouse button with the cursor between the left arrow and the slider causes
the dissipation display to move backward one screen.

(d) Clicking any mouse button with the cursor between the slider and the right arrow causes
the dissipation display to move forward one screen.

(e) Pressing any mouse button with the cursor over the slider, and then dragging the slider

with the mouse button still pressed, causes the dissipation display to move in that direc-
tion.

Note: In (a) through (d) above, pressing the mouse button instead of clicking it causes continuous
motion.

(a) (©) €l (d) - =a-(b)
Figure 7 Scrollbar

Zooming Using The Mouse Or Zoom Menu

The mouse can be used to zoom into a range of tests and display power dissipation only for these
tests. This is accomplished by moving the mouse cursor to the starting (first) test to be displayed,
pressing and then holding the mouse SELECT button while dragging the mouse cursor to the end-
ing (last) test to be displayed, and then releasing the button.
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Zooming in or out can be done by pressing View in the bar menu and selecting one of the follow-
ing options in the View menu:
(@ Full zooms out to encompass all tests.
(b) Range zooms into a specified range (see below); no less than two tests, and no more
than all tests.
() Inzooms in by a factor of two, but displays no less than two tests.
(d) Out zooms out by a factor of two, but displays no more than all tests.

If Range is chosen, a Range Popup window will be displayed, as shown in Figure 8. After mak-
ing the desired entries in the Starting Test and Ending Test entry windows, pressing the OK but-
ton will update the display’s test range. Pressing the Cancel button causes any changes in the
entries to be ignored. If an entry is invalid for the starting or ending test when the OK button is
pressed, then the appropriate warning panel will be displayed.

Starting Test: |0

Ending Test: | 1326

‘ ok |  cancel

Figure 8 Range Popup

Panning And Zooming Using Action Keys

In addition to the methods described above, panning and zooming can be accomplished by the use
of designated keys, pressed while the mouse cursor is focused in the dissipation graph area. These
keys are listed in Table 1.
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Table 1: List of Action Keys

Key Description
forF Zooms display to full view.
| or "<Left> Pans display backward one test.
L or ~<Left> Pans display backward one screen.
r or ~<Right> Pans display forward one test.
R or <Right> Pans display forward one screen.

In the table, “*” means “simultaneously hold down the <Control> key”, <Left> is the left arrow
keypad key, and <Right> is the right arrow keypad key.

Note: Holding any of these keys for an extended period will cause repeated action.

Modifying Calculation Parameters

You may modify the two global parameters that effect the computation of power by selecting
View in the bar menu and then selecting Setup in the View menu. This will popup the Display
Entry Dialog Box shown in Figure 9.

Vidd: |5

Capacitance Scale: |1

Average Markers:
Dissipation Jll Distribution i

‘ oK |  cancel |

Figure 9 Display Entry Dialog Box

There are two value entries in this form: VVdd and Capacitance Scale. These parameters are used
to calculating the energy saved and retrieved in capacitive nodes (see Calculation of Normalized
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Power Consumption). By default, VVdd is 5 volts and Capacitance Scale is 1xfarads. One of the
two entry windows will have input focus, that is, its border will be highlighted and it will be ready
to accept keyboard input. To modify the contents of the other entry window, move the cursor into
the entry window and click the mouse SELECT button. After making the appropriate modifica-
tions, “press” OK to accept the entries, or Cancel to abort changing these parameters.

An alternative method of modifying these defaults is to use the appropriate commands into the
command file. The vdd statement will override the default value, and the capscale statement will
override the default capacitance scale. The format for these commands can be found in Table 4 on
page 32.

The Average Markers check box below the text entry windows allows you to turn on or off the
average line marker in the dissipation or distribution graph windows.

Selecting Signals For Analysis

You may decide to look at an isolated area of the design for more detailed analysis. Xpower offers
a method for selecting which signals to include or exclude from the analysis. This mechanism is
independent of the automatic suppression and command file suppression defined in later chapters.
If the Signal button is pressed on the bar menu, the Signal Select Dialog is displayed as shown in
Figure 10.
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Figure 10 Signal Select Dialog

The Filter text entry section at the top of the form allows a regular expression to be entered to
match entries in the scrolling lists below. Which scrolling list that the filter corresponds to
depends on which options button (included or excluded) is used.

Regular expression is zero or more decision branches, which are separated by a ‘|’. A regular
expression will match any signal that matches any one of the branches.

A branch is one or more pieces, concatenated together. A match is made if all the pieces match.

A piece is an atom, possibly followed by a ‘#’, “+’, or “‘@’. An atom is a regular expression within
parenthesis, a range contained within ‘<’ and ‘>’ characters, a ‘$’, or a ‘\’ followed by any single
character.
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A range sequence is a sequence of characters enclosed in “>” and ‘>’ characters, it normally
matches a single character from this sequence. If the sequence begins with “** then it will match a
single character not from this sequence. If two characters are separated by a -, then this specifies
all characters from the first character, to the second, in ASCII sequence. For example, <0-9> will
match any digit character.

Table 2 below lists all the meta characters allowed in regular expressions:

Table 2: Regular Expression Meta Characters

Character

Description

Matches any single character.

Delimits a list of acceptable match characters. The list may
include a range, such as a-z (to represent all lowercase letters).
“ha<td>" will match the signals “hat” or *had”.

Matches any sequence of characters. “a*b” will match any signal
that starts with the character “a” and ends with the character “b”,
including a signal called “ab”.

Matches zero or one occurrences of the previous character or
expression group. “(ab)#d” will match “d”, “abd”, etc.

Matches one or more occurrences of the previous character
expression grouping. “a+b” will match “ab”, “aab”, “aaab”, etc.

Matches zero or more occurrences of the previous charac-
ter.“a#b” will match “b”, “ab”, “aab”, etc.

0

Delimits an expression grouping.

Logical Or of expression grouping. “(ab | cd)efg” will match the
signals “abefg” and *“cdefg”.

Escape character causing the next character is to be used literally.
The “\” must be used to specify any of the meta characters
described in this table to represent themselves. “a\$b” will match
the signal “a$b”, but “a$b” will match “a0Ob”, “a.b”, etc.
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Each option button has the options: Select Filtered, Select All, Deselect Filtered, Deselect All,
Invert, Search Down, and Search Up.

Select Filtered selects all signals in the corresponding list that match the regular expression in the
Filter text field.

Select All selects all signals in the list.

Deselect Filtered de-selects all signals that match the regular expression in the Filter text field.
Deselect All deselects all signals in the list.

Invert will make all selected signals deselected, and all deselected signals selected.

Search Down will look for a match for the regular expression in the Filter text field from the cur-
rent cursor position, to the end of the list. If the match is not displayed, then the list will scroll to
show the match.

Search Up will look for a match for the regular expression in the Filter text field from the current
cursor position, to the start of the list. If the match is not displayed, then the list will scroll to show
the match.

Once you have chosen which signals in the list to move, pressing the appropriate arrow box
located between the lists, will move the selected signals to the appropriate list. When you have
finished splitting the signals as needed, you need to press the OK or Apply button to update the
analysis. Pressing OK, will dismiss the Signal Select Dialog box, whereas Apply will not. If you
decide not to update the analysis, press the Cancel button, which reverts all selections since the
last apply, and dismisses the Dialog box.

Signals that have been suppressed by the command file (discussed later), take precedence over the
included/excluded attributes set in the Signal Select Dialog box. You may save the suppressed and
excluded signals to a file by selecting the Save button in the File bar menu. This can later be
restored by using the -c command line switch, or the Restore button in the File bar menu shown
in Figure 11:

Fie | Display

Open

Save

Ll
—

Restore
Print
Exit 1.

|
Figure 11 The Save and Restore Command Menu buttons.
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Requesting Summary Statistics

A popup window can be summoned that displays the current parameter settings and summary
information on the range of test stimuli currently being viewed in the dissipation graph area, the
average power consumption, and the test at which maximum power consumption occurs. This
popup window, the Summary Statistics window, is brought up by selecting the Statistics item in
the Display menu. To dismiss the window, “press” the Close button in the window.

Figure 12 illustrates the Summary Statistics window for the display of Figure 6.

Capacitance is scaled by le-12

Wdd is 5 Volts

1148 Tests displayed

345140 Transitions analysed

Fower Usage:
Average is b,45823 mll/MHz per test
Maximum is 25,6588 mW/MHz at test 3203559

Close

Figure 12 Summary Statistics Display

Displaying The Distribution Graph

The Distribution Graph displays the number of tests found at each power level within the range of
tests viewed in the dissipation graph area. It can be brought up by selecting the Distribution
item in the Display menu. To dismiss the window, “press” its Close button.

Figure 13 illustrates the Distribution Graph window for the display of Figure 6.
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Oynamic Fower Distribution
Huomber of Vectors wvs, Vector Fower (mblAMHzZ)
P p—
] ) J—
25 —
o R | e
0 110 20

Figure 13 Distribution Graph Display

Generating A Report

A report in textual or PostScript format can be sent to a file or printer by selecting the Print item
in the File menu, as shown in Figure 14 below.

Fie | Display

Exit 1 -

Figure 14 Print Item in File Menu
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Xpower will then display the Print Dialog Box shown in Figure 15. Near the top of the dialog
panel is a text entry window, which can be used to qualify the Destination. If the Destination
selected is Printer, then you can use the text entry window to specify the name of the printer; if
left blank, the default printer for your system is used. If the Destination selected is File, then you
can use the text entry window to specify the name of the file; if left blank, the history file name,
with the extension .ps, is used.

Selecting PostScript in the Output Format box will cause the output to be in the PostScript lan-
guage, describing the dissipation and distribution data as graphs similar to the window displays.
Selecting Ascii will choose output in standard Ascii text format with the dissipation and distribu-
tion data in tabular form.

Selecting US Letter in the Output Size box will size and offset the PostScript output for the US
letter standard 8.5 X 11 inch paper. Selecting A4 will size and offset the PostScript output for the
A4 standard 210 X 297 mm paper.

The Output Orientation box orients the page for PostScript output. Selecting Portrait will ori-
ent the page so its vertical edge is along the paper’s long dimension. Selecting Landscape will
orient the page so its vertical edge is along the paper’s short dimension.

If your PostScript Printer, or display, can handle color, then a color can be chosen for the graph
displays. This is accomplished by selecting a color in the Graph Color box.

The Output Contents box allows you to select the information to be put into the report:

(@) Selecting Header causes header information to be included in the report. The header
information includes the title, the type of stimuli, the number of tests per cycle, the range
of tests analyzed, and the voltage used in the calculation.

(b) Selecting Statistics causes the statistical information to be included in the report in a
tabular format and grouped by output-only nodes, internal-only nodes and total nodes.
This information includes the number of nodes, the average node capacitance, the aver-
age power, and the maximum per-test power dissipation.

(c) Selecting Distribution causes the distribution data to be included in the report.
(d) Selecting Dissipation causes the dissipation data to be included in the report.

(e) Selecting Average causes the average power lines to be included in the PostScript dissi-
pation and distribution graphs.

(F)  Selecting Logo causes the Genashor Logo to be included in the PostScript Report
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Destination:

Printer 4 File -

Fomat:

PosiScript 4 Ascii ~

Oulput Sze: Ouiput Orie ntation: Graph Color:
US Letter 4 Portrait 4 Black ¥
Ad Landscape - Red -~
Elue - -
Green -
Output Contents:

Header [l Distribution [l Average [l
Statistics ll  Dissipation [l Logo

‘ ok | cancel |

Figure 15 Print Dialog Box

If the file specified in the text entry window already exists, Xpower brings up the dialog box
shown in Figure 16, asking whether the existing file should be overwritten. “Press” OK to over-
write the file, or Cancel to subsequently specify a different file.
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Overwirte mychip.ps?

‘ Ok Cancel

Figure 16 Dialog Box For Overwriting Existing File

If the file specified in the text entry window cannot be created (usually due to lack of write privi-
lege or an attempt to overwrite a protected file), Xpower brings up the dialog box shown in
Figure 17. “Press” OK to specify another file, or Cancel to abort creation of the file.

Could not open ‘'mychip.ps’ for write,

‘ ok | cancel

Figure 17 Dialog Box For Failed File Creation

Figure 18 illustrates the Postscript printout generated for a display similar to the one shown in
Figure 6, reduced to 75% of its actual size.
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XPOWER (Version 2.00.02)

ynamic Power Consumption Report for, /home/gendel/gary/work/Xpower/chip,
using timing generator stimulus, with 1 test per cycle, 5V vdd.
Analysed Test 1 to Test 37951

OUTPUT INTERNAL TOTAL
Number of Nodes : 37 12586 12623
Average Node Capacitance : 13.70 0.27 0.31 (pF)
Average Power : 0.38 8.78 9.16 (mW/MHz)
Maximum Power : 10.56 18.89 25.66 (mW/MHz)
at test : 7303 32039 32039

Graph of Dynamic Power Distribution

75 —

50 —

25 —

Number of Vectors

"

0 [THY
I I I I I

0 5 10 15 20 25

Vector Power (mW/MHz)

Graph of Dynamic Power Dissipation

25 —

20 —

15 —

10 —

Vector Power (mW/MHz)

0 10000 20000 30000

Vector Number

Figure 18 PostScript Printout Corresponding To The Display Of Figure 6
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The Help Bar Menu Item

Selecting this item will cause a scrollable help window to display information on Xpower usage,
as shown in Figure 19.

Leaving =power

To exit Xpower, select the "Exit’ option from the "Fle’
menu.

[

Power Dissipation Zoom

Mouse:

Zpower allows zooming on a portion of the power
dissipation display. This is accomplished by placing the
mouse cursor on the left edge of the area to zoom in on,
pressing and holding any mouse button, dragging the
cursor to the right edge of the area to zoom in on, and
then releasing the button. 7

Figure 19 Help Information
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The Info Bar Menu Item

Selecting this item will display an information box containing the current version of Xpower, as
shown in Figure 20. “Pressing” OK will dismiss this window.

— ol

Xpower Yersion 2.00.02.

Dynamic power analysis program.
Copyright {c) 1992-1994 Genashor Corp.
All Rights Reserved.

oK |

Figure 20 Xpower Info Display

Suppressing Transitions From The Power Consumption Total

There are a number of cases where a user may not want certain signals or signal transitions
included in the power consumption statistics. Since a change in a primary input is really the result
of energy expended by an external device, all energy associated with these transitions is automat-
ically discounted by Xpower. In addition, the primary wire-tied signal transitions are suppressed
if the wire-tied result is the same as (was caused by) an external source (primary input or bus).
Xpower uses the SIMIC naming convention to determine whether there is an external driver for a
wire-tie. Simic convention is to use the signal’s name, prefixed with a period (.) for the external
driver. For example, if a primary bus is called DATA1, then the external driver for this bus is
called .DATAL. In addition to the primary signals, the SIMIC constants ONE and ZERO are also
discounted.

There are other topological situations that Xpower doesn’t recognize, that may need to be identi-
fied for suppression, in order to produce accurate results. Xpower offers a simple mechanism for
specifying these suppressions, via the command file:
(@) suppress <signal>
Where <signal> is the name of the signal to suppress. In this form, the suppress com-
mand will cause the removal of all transitions from the power consumption analysis.
(b) suppress <signall> <signal2>
Where <signall> is the name of the signal to suppress if it matches the current value of
the signal specified in <signal2>
(c) nosuppress <signal>
This command is used to remove a signal from Xpower’s automatic suppression, if
desired. <signal> is the name of the signal to include without suppression.
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(d) ignoreup <signal>
Will suppress low to high transitions of the signal <signal>. This command is useful for
indicating the presence of external pullup resistors.

(e) ignoredown <signal>
Will suppress high to low transitions of the signal <signal>. This command is useful for
indicating the presence of external pulldown resistors.

(f) exclude <signal>
Performs the same functionality as the suppress command, except these can be included
interactively via the Signal Select Dialog.

(9) reset
removes all suppressions and exclusions from signals.

A signal is only allowed to have one suppression specification. If more than one specification is
issued, the subsequent specifications will be ignored and an appropriate error message displayed
at the terminal. However, the same signals may have a suppression and exclusion concurrently
assigned.

Changing Files For Analysis

You may run as many Xpower processes as your operating system will allow. Once a process has
started, you may, at any time, select new files for analysis. In this event, the old analysis will be
discarded and the requested analysis performed.

Selecting New Files In Xpower

To choose new files to be analyzed, select the Open item from the File menu as shown in
Figure 21. Xpower will ask for confirmation as shown in Figure 22. If you choose Cancel, the
displays will continue to show the results of the current analysis. If you choose OK, Xpower will
display the Filename Dialog Box, as shown in Figure 2. Update the entry fields with the correct
information, following the procedure outlined in Starting Xpower on page 7.

File | Display
o [
Save

- Ct
Restore
Print

Exit 1.z
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Figure 21 Open Item In File Menu

Current File will he discarded

‘ OK | Cancel

Figure 22 Confirmation Box For Open Selection.

Selecting New Files Outside Of Xpower

A simple mechanism exists that allows another process to instruct a running Xpower process to
open new input files for analysis. This can be used to maintain an open Xpower window in a CAE
framework, and automatically update the displays after a new simulation run. The gcommand
program provides this interface. The format for invoking gcommand is:
gcommand <window title> <arg list>

where <window title> is the Xpower main window title name (Xpower by default), and <arg
list> is a list of arguments to be sent to this window. The window title can be changed by the
-title X-resource option. The X-resource options accepted by Xpower are described in X-

Resources Used By Xpower below. The arguments are the same as if Xpower were invoked with a
command line.

For example, if the title of main Xpower window is Xpower@chaos, then you can make this
Xpower process analyze the history files named mycpu, with the following command:

gcommand Xpower@chaos mycpu
The effect is the same as if you started Xpower with the equivalent argument list.

If there is more than one window with the specified title, then the first window encountered will
be updated.

Important: gcommand arguments must not contain X-resource options.

Page 28 Genashor Corp. September 1993



Version 2.0.0 Xpower User’s Guide

X-Resources Used By Xpower

The user may specify X-resources by using the command line switches (long or short), or by
entering the resource assignment into an X-resource file. Xpower searches for user-set resources
in the following order (highest precedence last):

(@ If $XFILESEARCHPATH exists, search along this path, otherwise use /usr/lib/X11 as a
path prefix with the following search string:
“/%L/%T/%N%C:/%I/%T/%N%C:/%L/%T/%N:/%I/%T/%N:/%T/%N”

(b) If $XUSERFILESEARCHPATH exists, search along this path. Otherwise, if
$XAPPLRESDIR exists, use this (otherwise $SHOME) as a path prefix with the follow-
ing search string:

“/%L/%N%C:/%I/%N%C:/%L/%N:/%Il/%N:/%N".

(c) If RESOURCE_MANAGER property exists, read it, otherwise read

$HOME/.Xdefaults.

(d) If $XENVIRONMENT exists, read it, otherwise read SHOME/.Xdefaults-hostname.
Where hostname is the name of the current host.

() Read the command line switches.

Notes: The words beginning with a dollar sign ($) (for example SLANG and $HOME), are system
environment variables. Search string substitutions can be found in the Xt reference documenta-
tion. Currently, the %C substitution string is not supported, and an empty string will be used if
found.

For example, if you wanted the background color to be blue, you could either use the command
line switch:

Xpower -bg blue

or insert the following line in one of the X-resource files mentioned above.
Xpower .Background: Blue

Table 3 lists the X-resources that Xpower recognizes.

Table 3: List of Xpower X-resources

Short Long Command
Command ; . X-resource Name Description
X : Line Switch
Line Switch
-bc -baseColor BaseColor Specifies the color to use for all
window backgrounds. The default
is “Tan”.
-bg -background BackGround Specifies the color to use for the
graph backgrounds. The default is
“White”.
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Table 3: List of Xpower X-resources

Short Long Command
Command g . X-resource Name Description
; . Line Switch
Line Switch
-display display Specifies the display device for

Xpower output. The default is the
DISPLAY environment variable.

-dsc -darkShadeColor DarkShadeColor | Specifies the color for dark shad-
ing used for 3-Dimensional
appearance. Default is “Black”.

-ff -fixedFont FixedFont Specifies the font to use for all text
displays that require fixed spaced
fonts. Default is “6x9”.

-fg -foreground Foreground Specifies the color to use for all
window foregrounds. Default is
“Black”.
-geometry geometry Specifies the size and/or the loca-

tion of the main Xpower window.
The size is defined by the format:
WxH, where W is the width and H
is the height. The location is in the
format {+-}X{+-}Y, where X is
the x position relative to the right,
if positive, or left, if negative, and
Y is the y position relative to the
top, if positive, or bottom, if nega-
tive. If the width or height is
smaller than the minimum,
Xpower will force the window to
the minimum value.

-gac -graphAxisColor GraphAxisColor | Specifies the color to use for the
graph axis and labels. Default is
“Black”.

-gc -graphColor GraphColor Specifies the color to use for the

graphs. Default is “Red”.

-hl -highlight Highlight Specifies the color to use to high-
light the currently selected entry
widget. Default is “Red”.
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Table 3: List of Xpower X-resources

Short Long Command
Command 9 : X-resource Name Description
; . Line Switch
Line Switch

-Isc -lightShadeColor LightShadeColor | Specifies the color for light shad-
ing used for 3-Dimensional
appearance. Default is “White”.

-mka -menuKeyAcceler- | MenuKeyAccelera- | Specifies whether underlining and
ator tor accelerator keys are used for menu
selection. Default is “On”.

-0S -outputSize OutputSize Specifies the default paper size for
report. Valid values are “A4” and
“USletter”. Default is “USletter”.

-shc -scrollBarColor ScrollBarColor Specifies the color for the scrollbar
buttons and slider. Default is to use
BaseColor.

-tfc -textFieldColor TextFieldColor Specifies the background color for
all text display fields. Default is
“White”.

-title title Sets the Xpower window title.
Default is “Xpower”.

-vf -variableFont VariableFont Specifies the font to use for all text
displays that use proportionally
spaced fonts. Default is “variable”.
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The Command File

The command file is read just prior to performing the power consumption analysis. Comments are
allowed in the command file by prefixing the comment with a number sign (#). Commands are
case insensitive, however the arguments are case sensitive. Table 4 lists all valid commands.

Table 4: List of Commands

Command Description
capscale <scale> Sets capacitance scale value to <scale>.
This can be changed interactively in the
Setup Dialog.
exclude <signal> Suppresses specified signal in analysis.

These may be changed interactively in the
Signal Select Dialog Box.

ignoredown <signal> Ignores high to low transitions for signal
<signal>.
ignoreup <signal> Ignores low to high transitions for signal
<signal>.
nosuppress <signal> Removes suppression of signal <signal>.
reset Removes all suppressions and exclusions
from signals.
suppress <signal> Ignores all transitions for signal <signal>
suppress <signall> <signal2> Ignores transitions for signal <signall>, if
it’s final value is the same as signal
<signal2>.
vdd <voltage> Sets vdd value to <voltage>. This can be

changed interactively in the Setup Dialog.
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